
BAB 2

TINJAUAN PUSTAKA

2.1 Penelitian terdahulu
Untuk mendapatkan hasil yang optimal, dilakukan kajian dari beberapa

penelitian-penelitian terdahulu, sehingga bisa dijadikan referensi dalam penelitian

dengan tujuan agar diperoleh perbandingan kelebihan pada masing-masing

perancang.

Pada penelitian terdahulu yang dilakukan oleh (Yohana tri utami dan Yuri

rahmanto, 2021) dalam jurnal yang berjudul “Rancang bangun sistem pintu parkir

otomatis berbasis arduino dan RFID”) Penelitian ini menyimpulkan bahwa

dibutuhkan suatu alat yang dapat bekerja secara otomatis tanpa harus

menggunakan tenaga manusia untuk mengoperasikannya . Poin penting dalam

rancangan alat ini adalah bagaimana membatasi akses yang dimiliki untuk

mengoperasikan alat tersebut. Setelah mengetahui poin penting tersebut peneliti

memiliki ide untuk membatasi akses untuk mengoperasikana alat tersebut

menggunakan RFID (Radio Frequency Identification) dimana benda ini hanya

dimiliki oleh para karyawan ataupun nasabah pada suatu instansi terkait . Sistem

kerja dari alat ini adalah RFID reader akan membaca atau memindai alamat pada

RFID card yang dimiliki oleh karyawan atau nasabah instansi tersebut. Bila data

yang dibutuhkan dan data yang dimasukan sesuai maka perangkat mikrokontroler

akan memberi perintah kepada perangkat agar membuka dan menutup palang

pintu tersebut tanpa harus menggunakan campur tangan pihak ketiga lagi .

Pada penelitian terdahulu yang dilakukan oleh (suci br kembaren, elsadora

haroannauli patricia br gurning dan any kurniawaty yapie, 2023) dalam jurnal

yang berjudul “IOT pada purwarupa sistem keamanan pintu kantor dengan sensor

rfid dan pir berbasis telegram”) U. Rancangan keamanan ini tidak mengandalkan

mekanik sebagai interfacenya melainkan menggunakan perangkat elektronik yang

cukup sulit untuk dibobol karena selain diperlukan pengetahuan mengenai

elektronik, para pelaku kriminalitas juga harus memilki pengetahuan di bidang



pemrograman dan teknologi informasi. Berbeda dengan kunci mekanik, kunci

elektronik pada rancangan keamanan ini menggunakan Radio Frequency

Identification (RFID) sebagai pembukanya. RFID (Radio Frequency

Identification) merupakan proses pengidentifikasian suatu objek secara otomatis

dengan frekuensi radio. Dengan adanya alat yang memanfaatkan RFID dan

infrared ini, diharapkan dapat mencegah terjadinya hal tersebut, karena fungsi alat

ini sebagai pendeteksi jika ada orang asing yang masuk tanpa mempunyai akses

kartu dan dapat memberi notifikasi jika orang asing tersebut

memaksa masuk.

Pada penelitian terdahulu yang di lakukan oleh (Nurwijayanti KN dan

Abdul Basyir, 2022) dalam jurnal yang berjudul “Perancangan Sistem Keamanan

Pintu Ruangan Otomatis Menggunakan RFID Berbasis Iinternet Of Things (IoT)”

penelitian ini merumuskan permasalahan umum pintu rumah yang hanya

mengandalkan pengamanan dengan kunci tunggal pintu biasa, sehingga

diperlukan rancangan keamanan yang mampu melindungi rumah dengan kualitas

yang tinggi. Sistem keamanan ini menggunakan pembatasan akses dengan dua

metode, diantaranya dengan membatasi waktu-waktu tertentu yang dibolehkan

untuk mengakses ruangan, serta menggunakan kartu tag RFID untuk memberi

akses hanya pada anggota yang telah memiliki kartu tag RFID terdaftar. Ketika

diketahui adanya pembobolan paksa yang dilakukan seseorang untuk mengakses

ruangan, akan ada notifikasi yang dikirimkan Bot Smartphon.

Pada penelitian terdahulu yang di lakukan oleh (setiawan jodi, mirhan

siregar, asmira, nilam kusuwati, 2022) dalam jurnal yang berjudul “prototype

sistem keamanan pintu rumah menggunakan tag card dan pin berbasis arduino

uno” Berbagai penelitian telah dilakukan oleh peneliti sebelumnya diantarannya

penelitian tentang sistem pengaman kunci pintu ruangan otomatis menggunakan

RFID, dimana pintu akan terbuka otomatis jika tag RFID yang di baca RFID

reader sesuai dengan database . Selanjutnya penelitian tentang sistem pengaman

pintu rumah berbasis Arduino Uno yang di hubungkan dengan smartphone

Android menggunakan Bluetooth , sistem pengunci rumah menggunakan RFID

dan Selenoid Door Lock , sistem keamanan pintu menggunakan sensor sidik jari ,



Sistem keamanan pintu rumah berbasis IoT , sistem keamanan rumah berbasis

mikrokontroler Arduino dan SMS Gateway , dan sistem keamanan kunci pintu

rumah berbasis arduino uno dan sensor PN532, dimana penelitian ini

menggunakan modul PN532 sebagai pembaca UID dari e-KTP, hasil penelitian

ini menunjukkan sistem pengaman bekerja dengan jarak maksimal 5 cm dan

rentang sudut maksimal 0-800. Mencermati beberapa penelitian sebelumnya telah

banyak metode yang digunakan sebagai sistem pengamanan kunci rumah seperti

RFID, Bluetooth, solenoid door lock, SMS Gateway, dan berbasis IoT. Namun,

dari beberapa metode tersebut memiliki kelebihan dan kekurangannya masing-

masing. Misalnya berbasis SMS Gateway atau IoT dimana memiliki kekurangan

karena memerlukan biaya untuk penggunannya. Begitupun pada penggunaan

Bluetooth yang hanya terkoneksi dengan jarak maksimal 15 meter dan untuk

penggunaan jangka panjang perlu menggunakan alat pendingin untuk

meminimalisir panas pada Selenoid Door Lock. Berdasarkan beberapa penelitian

sebelumnya dan permasalahan yang telah di ruaikan, maka peneliti melakukan

penelitian untuk sistem keamanan pintu rumah dengan menggunakan Tag Card

dan PIN berbasis Arduino Uno.

Perbandingan penelitian terdahulu dengan penelitian sekarang dapat

dilihat pada tabel 2.1.

Tabel 2.1 perbandingan penelitian terdahulu dengan penelitian yang dilakukan

No Penelitian Persamaan Perbedaan

1. Yohana tri utami dan

Yuri rahmanto, 2021

Rancang bangun

sistem pintu parkir

otomatis berbasis

arduino dan RFID

1.) menggunakan RFID

sebagai input

2.) meninkatkan sistem

keamanan pintu

1.)menggunakan

mikrokontroler Arduino

Nano

2.) menggunakan

notifikasi saat pinu

terbuka.



2. suci br kembaren,

elsadora haroannauli

patricia br gurning dan

any kurniawaty yapie,

2023,

IOT pada purwarupa

sistem keamanan pintu

kantor dengan sensor

rfid dan pir berbasis

telegram

1.) menggunakan RFID

sebagai input

2.) menggunakan 3

media yaitu , kartu tag

dan smartphone

3.) output dari sistem

berupa solenoid

doorlock sebagai

pengunci dan pembuka

pintu, LCD sebagai

penampil digital untuk

memonitor sistem ini

bekerja

1.) menggunakan

mikrokontroler arduino

nano

3. Nurwijayanti KN dan

Abdul Basyir,2022,

perancangan sistem

keamanan pintu

ruangan otomatis

menggunakan RFID

berbasis iot.

1. )meningkatkan

keamanan pintu

rumah,ruangan dll.

1.) menggunakan

mikrokontroler arduino

nano

4. setiawan jodi, mirhan

siregar, asmira, nilam

kusuwati, 2022,

prototype sistem

keamanan pintu rumah

menggunakan tag card

dan pin berbasis

arduino uno

1. ) meningkatkan

keamanan pintu rumah

2. ) menggunakan

sensor RFID

1.) menggunakan

mikrokontroler arduino

nano



2.2 Rancang Bangun

(Menurut Pressman 2009) perancangan atau rancang merupakan

serangkaian prosedur untuk menterjemahkan hasil analisa dan sebuah sistem ke

dalam bahasa pemrograman untuk mendeskripsikan dengan detail bagaimana

komponen-komponen sistem di implementasikan. Menurut Pressman (2009)

pengertian pembangunan atau bangun sistem adalah kegiatan menciptakan sistem

baru maupun mengganti atau memperbaiki sistem yang telah ada secara

keseluruhan. Jadi dapat disimpulkan bahwa Rancang Bangun adalah

penggambaran, perencanaan, dan pembuatan sketsa atau pengaturan dari beberapa

elemen yang terpisah kedalam suatu kesatuan yang utuh dan berfungsi. Dengan

demikian pengertian rancang bangun merupakan kegiatan menerjemahkan hasil

analisa ke dalam bentuk paket perangkat lunak kemudian menciptakan sistem

tersebut atau memperbaiki sistem yang sudah ada.

2.3 Sistem

( menurut Laudon, Kenneth C., and Jane P. Laudon 2020 ) Sistem adalah

suatu kesatuan yang terdiri dari berbagai komponen atau elemen yang saling

berinteraksi dan bekerja sama untuk mencapai tujuan tertentu. Dalam konteks

umum, sebuah sistem dapat diartikan sebagai rangkaian elemen yang terorganisir

dan diatur sedemikian rupa sehingga menciptakan suatu pola kerja yang efektif

dan efisien.

Karakteristik Sistem:

1. Komponen (Elements): Bagian-bagian atau elemen-elemen yang

membentuk suatu sistem.

2. Interaksi (Interaction): Hubungan antara elemen-elemen dalam sistem

yang memungkinkan mereka bekerja sama.

3. Tujuan (Objective): Setiap sistem dirancang untuk mencapai tujuan

tertentu.

4. Lingkungan (Environment): Sistem tidak berdiri sendiri, melainkan

berinteraksi dengan lingkungannya.



5. Umpan Balik (Feedback): Proses untuk memastikan bahwa sistem tetap

berada pada jalur yang benar dan mencapai tujuannya.

Contoh Sistem:

1. Sistem Komputer: Terdiri dari perangkat keras (hardware), perangkat

lunak (software), dan pengguna.

2. Sistem Ekonomi: Meliputi interaksi antara berbagai elemen seperti pasar,

kebijakan pemerintah, dan konsumen.

2.4 Mikrokontroler

( menurut Mazidi, Muhammad Ali, et al. 2014 ) Mikrokontroler adalah

sebuah perangkat semikonduktor yang berfungsi sebagai otak dari sistem

elektronik yang mampu mengendalikan berbagai fungsi dan operasi dalam suatu

perangkat. Mikrokontroler biasanya terdiri dari prosesor (CPU), memori (RAM,

ROM), dan komponen input/output (I/O) yang terintegrasi dalam satu chip.

Mikrokontroler digunakan dalam berbagai aplikasi seperti otomasi industri,

peralatan rumah tangga, perangkat medis, dan sistem kendali otomatis.

Karakteristik Mikrokontroler:

1. Prosesor (CPU): Inti dari mikrokontroler yang mengendalikan operasi dan

memproses data.

2. Memori:

1. RAM (Random Access Memory): Untuk penyimpanan data

sementara.

2. ROM (Read Only Memory): Untuk menyimpan program yang

dijalankan oleh mikrokontroler.

3. Port I/O: Saluran yang memungkinkan mikrokontroler berkomunikasi

dengan perangkat eksternal seperti sensor dan aktuator.

4. Timer/Counters: Fitur untuk mengukur waktu atau menghitung peristiwa.

5. Komunikasi: Mendukung protokol komunikasi seperti UART, I2C, SPI

untuk berinteraksi dengan perangkat lain.



Contoh Penggunaan Mikrokontroler:

1. Perangkat Elektronik Konsumen: Seperti remote control, mesin cuci, dan

sistem pendingin udara.

2. Otomotif: Untuk mengontrol fungsi seperti sistem injeksi bahan bakar dan

ABS (Anti-lock Braking System).

3. Robotik: Mengendalikan gerakan dan fungsi robot.

2.5 IOT (Internet Of Things)

( menurut Greengard, Samuel 2015 )Internet of Things (IoT) adalah

konsep di mana objek fisik yang dilengkapi dengan teknologi seperti sensor,

perangkat lunak, dan konektivitas internet dapat saling berkomunikasi dan

bertukar data satu sama lain tanpa memerlukan interaksi manusia langsung. IoT

memungkinkan berbagai perangkat seperti alat rumah tangga, kendaraan,

perangkat medis, dan mesin industri untuk terhubung ke internet dan berinteraksi

secara otomatis.

Karakteristik IoT:

1. Konektivitas: IoT memungkinkan objek untuk terhubung dan

berkomunikasi melalui internet, baik dengan perangkat lain maupun

dengan server pusat.

2. Sensor: Perangkat IoT sering dilengkapi dengan sensor untuk

mengumpulkan data dari lingkungan sekitar, seperti suhu, kelembaban,

gerakan, dan lokasi.

3. Data Real-time: IoT mengumpulkan dan menganalisis data secara real-

time untuk memberikan informasi yang berguna atau untuk

mengotomatisasi keputusan.

4. Interoperabilitas: Berbagai perangkat IoT dapat bekerja bersama dalam

sebuah ekosistem, meskipun mereka berasal dari produsen yang berbeda.



5. Otonomi: IoT memungkinkan perangkat untuk melakukan tugas-tugas

secara otomatis tanpa campur tangan manusia, misalnya melalui

pengaturan rumah pintar (smart home).

Contoh Penggunaan IoT:

1. Rumah Pintar (Smart Home): Penggunaan perangkat yang terhubung

untuk mengontrol pencahayaan, suhu, keamanan, dan peralatan rumah

tangga lainnya dari jarak jauh.

2. Kota Pintar (Smart City): Implementasi IoT untuk meningkatkan efisiensi

infrastruktur kota, seperti pengelolaan lalu lintas, energi, dan layanan

publik.

3. Industri 4.0: Penerapan IoT dalam otomasi industri untuk meningkatkan

efisiensi, produksi, dan keamanan di pabrik.

2.6 ESP32

2.6.1 penjelasan ESP32

( Menurut Santos, Peter 2018 ) ESP32 adalah sebuah mikrokontroler

yang dikembangkan oleh Espressif Systems yang terkenal dengan kemampuan

konektivitas nirkabel, khususnya Wi-Fi dan Bluetooth. ESP32 merupakan penerus

dari ESP8266 dan menawarkan fitur yang lebih canggih serta performa yang lebih

tinggi. Mikrokontroler ini banyak digunakan dalam aplikasi IoT (Internet of

Things) karena kemampuannya untuk menghubungkan perangkat ke internet

dengan mudah.

Karakteristik ESP32:

1. Prosesor Dual-Core: ESP32 dilengkapi dengan prosesor dual-core 32-bit

Xtensa LX6 yang berjalan pada kecepatan hingga 240 MHz.

2. Konektivitas: Mendukung Wi-Fi 802.11 b/g/n dan Bluetooth v4.2

BR/EDR dan BLE (Bluetooth Low Energy).

3. Memori: Memiliki RAM 520 KB dan berbagai pilihan penyimpanan flash.



4. GPIO: Menyediakan sejumlah pin General Purpose Input/Output (GPIO)

yang dapat digunakan untuk menghubungkan berbagai sensor dan

perangkat lain.

5. Peripherals: Mendukung berbagai antarmuka komunikasi seperti UART,

SPI, I2C, dan PWM, serta memiliki modul ADC dan DAC bawaan.

6. Efisiensi Energi: ESP32 dirancang untuk aplikasi dengan konsumsi daya

rendah, dengan mode tidur yang memungkinkan perangkat untuk

beroperasi dengan daya minimal.

Gambar 2.1 ESP32

2.6.2 Instalasi Perangkat Lunak

Instalasi perangkat lunak menjadi langkah krusial dalam

mempersiapkan lingkungan pengembangan untuk Arduino ESP32. Berikut adalah

panduan langkah demi langkah untuk menginstal Arduino IDE dan konfigurasi

awal board ESP32:

1. Unduh Arduino IDE:

 Kunjungi situs resmi Arduino untuk mengunduh versi terbaru dari

Arduino IDE.

 Ikuti petunjuk instalasi yang disediakan oleh sistem operasi yang Anda

gunakan (Windows, macOS, atau Linux).



2. Buka Arduino IDE:

 Setelah instalasi selesai, buka Arduino IDE di komputer Anda.

3. Tambahkan URL Board ESP32 ke Preferences Arduino IDE:

 Buka menu “File” > “Preferences” di Arduino IDE.

 Salin dan tempel URL board ESP32 ke dalam kolom “Additional Boards

Manager URLs”: https://dl.espressif.com/dl/package_esp32_index.json

 Klik “OK” untuk menyimpan perubahan.

4. Instal Board ESP32:

 Buka menu “Tools” > “Board” > “Boards Manager…”.

 Cari “esp32” dan instal board ESP32 yang disediakan oleh Espressif

Systems.

5. Pilih Board ESP32 yang Tepat:

 Setelah instalasi selesai, pilih board ESP32 yang sesuai dengan modul

ESP32 yang Anda gunakan melalui menu “Tools” > “Board”.

6. Pilih Port Serial:

 Hubungkan ESP32 ke komputer melalui kabel USB.

 Pilih port serial yang sesuai dengan ESP32 pada menu “Tools” > “Port”.

2.7 Arduino Nano

( menurut Banzi, Massimo, and Michael Shiloh 2014 )Arduino Nano

adalah sebuah mikrokontroler berbasis ATmega328 yang dirancang dalam bentuk

yang lebih kecil dan lebih kompak dibandingkan dengan papan Arduino lainnya

seperti Arduino Uno. Arduino Nano dirancang untuk proyek-proyek yang

membutuhkan ukuran yang kecil, dan sering digunakan dalam aplikasi yang

memerlukan pemakaian minimal ruang.



Gambar 2.2 arduino nano

Seperti yang kita ketahui, bahwa Arduino Nano adalah salah satu produk papan

sirkuit mikrokontroler berukuran kecil yang memiliki beberapa pin.

Berikut pinout Arduino Nano.

Gambar 2.3 pinout arduino nano

Berdasarkan gambar di atas, berikut ini adalah penjelasan dan pembagian kategori

pin pada Arduino Nano beserta fungsinya.

1. Pin Input/Output Digital

Fungsi utama dari pin ini adalah untuk membaca sinyal digital,

yaitu berupa nilai 0 dan 1 atau ada juga yang menyebutnya logika TRUE



dan FALSE. Adapun untuk jumlah pin digital pada Arduino Nano yaitu

sebanyak 14 pin. Terhitung dari pin RX0, TX1, D2, dan sampai D13.

2. Pin Input Analog

Secara umum, fungsi pin ini adalah untuk membaca sinyal analog

untuk diubah ke dalam bentuk sinyal digital. Jumlah pin input analog

Arduino Nano berjumlah delapan. Terdiri atas pin A0, A1, A2, A3, A4,

A5, A6, dan A7. Namun perlu kamu ketahui bahwa diantara delapan pin

tersebut ada dua pin yang memiliki fungsi khusus, yaitu memungkinkan

terjadinya komunikasi I2C.

3. Pin Tegangan

Fungsi dari pin tegangan adalah memungkinkan kita untuk

mengatur tegangan yang ada pada Arduino. Beberapa contoh pin tegangan

dan fungsinya yaitu:

1. VIN, berfungsi sebagai tempat masuknya tegangan jika ingin

menambahkan tegangan eksternal

2. 5V, berfungsi memberikan tegangan yang besarnya 5 volt

3. 3, 3V, berfungsi memberikan tegangan yang besarnya 3,3 volt

4. GND (ground), berfungsi menghilangkan beda potensial jika

sewaktu-waktu terjadi kebocoran tegangan

5. AREF, berfungsi mengatur tegangan referensi eksternal sebagai

batas atas pin input analog

6. IOREF, berfungsi untuk memberikan referensi tegangan yang

beroperasi pada mikrokontroler

4. Pin RESET

1. Berfungsi untuk merestart ulang program yang sedang berjalan

pada Arduino. Caranya dengan menghubungkan pin RESET ke

salah satu pin digital lalu memasukkan script khusus.

https://www.aldyrazor.com/2020/07/arduino-adalah.html
https://www.aldyrazor.com/2020/07/arduino-adalah.html


2.8 Radio Frequency Identification (RFID)

( Menurut Roberti, Mark. 2020 )RFID (Radio Frequency Identification)

adalah teknologi yang menggunakan gelombang radio untuk mengidentifikasi dan

melacak objek secara otomatis melalui sebuah tag atau label yang terpasang pada

objek tersebut. RFID terdiri dari tiga komponen utama: tag RFID, pembaca RFID

(RFID reader), dan antena. Sistem ini sering digunakan dalam berbagai aplikasi

seperti logistik, manajemen inventaris, kontrol akses, dan pembayaran otomatis.

Komponen Utama RFID:

1. Tag RFID: Sebuah chip kecil yang menyimpan informasi unik tentang

objek, serta sebuah antena untuk menerima dan mengirim sinyal radio.

Tag ini bisa bersifat pasif (tanpa sumber daya internal) atau aktif (dengan

baterai internal).

2. Pembaca RFID (Reader): Perangkat yang memancarkan gelombang

radio untuk mengaktifkan tag RFID dan membaca informasi yang

dikirimkan kembali oleh tag.

3. Antena: Bagian dari pembaca atau tag RFID yang memancarkan dan

menerima gelombang radio.

Gambar 2.4 RFID



2.9 Liquid crystal display ( LCD )

( Menurut Brown, Keith 2019 ) LCD (Liquid Crystal Display) adalah

teknologi tampilan yang menggunakan sifat optik dari kristal cair untuk

menampilkan gambar, teks, atau video. LCD adalah jenis layar datar yang bekerja

dengan mengontrol aliran cahaya melalui lapisan kristal cair yang terletak di

antara dua lapisan kaca atau plastik transparan. Teknologi ini sering digunakan

dalam berbagai perangkat elektronik, seperti monitor komputer, televisi, ponsel,

kalkulator, dan jam tangan digital.

Karakteristik LCD:

1. Lapisan Kristal Cair: Kristal cair adalah material yang dapat mengalir

seperti cairan, tetapi memiliki struktur molekul yang teratur seperti

padatan. Ketika terkena medan listrik, orientasi molekulnya berubah,

sehingga dapat mengontrol cahaya yang melewatinya.

2. Pencahayaan Belakang (Backlight): LCD biasanya menggunakan sumber

cahaya belakang (backlight) seperti LED untuk menerangi layar, karena

kristal cair sendiri tidak menghasilkan cahaya.

3. Matrix Pasif dan Aktif: LCD dapat memiliki matriks pasif, di mana

kontrol piksel dilakukan secara baris dan kolom, atau matriks aktif, di

mana setiap piksel dikendalikan oleh transistor film tipis (TFT) untuk

memberikan respon yang lebih cepat dan kualitas gambar yang lebih baik.

4. Resolusi Tinggi: LCD dapat menampilkan gambar dengan resolusi tinggi,

detail yang jelas, dan kontras warna yang baik.

5. Efisiensi Energi: Dibandingkan dengan teknologi tampilan lainnya seperti

CRT (Cathode Ray Tube), LCD lebih hemat energi.



Gambar 2.5 LCD

2.10 Relay

( Menurut Beaty, H. Wayne, and Donald G.2013 ) Relay adalah sebuah

saklar elektrik yang dioperasikan secara elektromekanis atau elektronik. Relay

digunakan untuk mengendalikan sirkuit listrik dengan menggunakan sinyal

tegangan rendah untuk mengontrol sirkuit tegangan tinggi atau arus tinggi. Prinsip

kerja relay melibatkan penggunaan elektromagnet untuk membuka atau menutup

kontak saklar, sehingga memungkinkan atau memutus aliran listrik dalam sirkuit

yang dikendalikan.

Karakteristik Relay:

1. Elektromagnet: Relay biasanya terdiri dari kumparan elektromagnet yang,

ketika dialiri arus listrik, menghasilkan medan magnet. Medan magnet ini

menarik atau melepaskan kontak saklar, yang kemudian mengubah

keadaan sirkuit (ON/OFF).

2. Kontak Saklar: Relay memiliki satu atau lebih kontak yang dapat berupa

Normally Open (NO) atau Normally Closed (NC). Ketika elektromagnet

diaktifkan, kontak saklar akan berubah posisinya.

3. Isolasi: Relay memberikan isolasi listrik antara sirkuit kontrol dan sirkuit

yang dikendalikan, yang sangat penting untuk mengendalikan perangkat

bertegangan tinggi dengan sinyal rendah.



4. Jenis Relay: Ada beberapa jenis relay, termasuk relay elektromekanis,

relay solid-state, relay reed, dan relay waktu, yang masing-masing

digunakan untuk aplikasi yang berbeda.

Gambar 2.6 Relay

2.11 Solenoid Door Lock

( Menurut Miller, Paul 2020 )Solenoid door lock adalah sebuah sistem

penguncian pintu yang menggunakan solenoid, yaitu sebuah elektromagnet, untuk

mengendalikan mekanisme penguncian pintu. Solenoid dalam sistem ini berfungsi

sebagai penggerak yang membuka atau menutup kunci pintu dengan mengubah

posisi kunci secara otomatis ketika solenoid dialiri arus listrik.

Cara Kerja Solenoid Door Lock:

1. Solenoid: Solenoid adalah kumparan kawat yang dililitkan di sekitar inti

besi. Ketika arus listrik mengalir melalui kawat, medan magnet yang

dihasilkan akan menarik atau mendorong inti besi.



2. Mekanisme Kunci: Solenoid terhubung dengan mekanisme penguncian

pintu, seperti pin atau tuas yang akan bergerak untuk mengunci atau

membuka pintu.

3. Pengendalian: Pintu dapat dikunci atau dibuka dengan mengalirkan arus

listrik ke solenoid. Biasanya, ini dioperasikan melalui tombol, remote

control, atau sistem akses elektronik seperti kartu RFID.

Gambar 2.7 solenoid door lock

2.12 Kabel Jumper

( Menurut Williams, Terry, and Chris Williams. 2018 ) Kabel jumper

adalah kabel pendek yang digunakan untuk menghubungkan dua titik dalam

sirkuit elektronik. Kabel ini sering digunakan dalam prototipe dan perakitan

rangkaian untuk membuat sambungan sementara atau permanen antara komponen,

terutama dalam breadboard atau papan sirkuit cetak (PCB).

Karakteristik Kabel Jumper:

1. Konektor: Kabel jumper biasanya dilengkapi dengan konektor seperti

header pin atau pin header yang memungkinkan kabel terhubung dengan

mudah ke papan sirkuit atau komponen.



2. Ukuran dan Panjang: Tersedia dalam berbagai panjang dan ukuran untuk

memenuhi kebutuhan koneksi yang berbeda. Kabel jumper umumnya

berukuran kecil dan fleksibel.

3. Jenis:

1. Jumper Wires: Biasanya berupa kabel dengan dua ujung terbuka

yang bisa langsung dihubungkan ke pin atau header.

2. Jumper Cables: Kabel yang memiliki konektor di kedua ujungnya,

sering digunakan dalam sistem yang lebih permanen atau

terintegrasi.

Gambar 2.8 kabel jumper

2.13 Buzzer

( Menurut Hsu, Chung-Chih. 2016 ) Buzzer adalah perangkat elektronik

yang digunakan untuk menghasilkan suara atau bunyi dengan cara mengubah

sinyal listrik menjadi gelombang akustik. Buzzer sering digunakan dalam

berbagai aplikasi seperti alarm, notifikasi, dan indikator dalam perangkat

elektronik.



Jenis Buzzer:

1. Buzzer Elektromagnetik: Menggunakan elektromagnet untuk

memindahkan diafragma dan menghasilkan suara. Buzzer ini sering

disebut sebagai "electromagnetic buzzer" atau "mechanical buzzer."

2. Buzzer Piezoelektrik: Menggunakan efek piezoelektrik, di mana bahan

piezoelektrik menghasilkan suara ketika diberi tegangan listrik. Buzzer ini

dikenal sebagai "piezo buzzer" dan biasanya lebih kecil serta lebih efisien

dalam hal konsumsi daya.

Karakteristik Buzzer:

1. Frekuensi: Buzzer dapat menghasilkan suara pada frekuensi tetap atau

variabel, tergantung pada desain dan aplikasi. Frekuensi ini biasanya

diukur dalam Hertz (Hz).

2. Tegangan Operasi: Buzzer biasanya beroperasi pada berbagai tegangan,

mulai dari beberapa volt hingga puluhan volt, tergantung pada jenis dan

desainnya.

3. Volume: Volume suara yang dihasilkan dapat bervariasi, dan beberapa

buzzer dilengkapi dengan pengaturan volume atau intensitas suara.

Gambar 2.9 buzzer



2.14 Adaptor 12 Volt

( Menurut Rizzoni, Giorgio. 2018 )Adaptor 12 volt adalah perangkat

yang mengubah tegangan listrik dari sumber daya utama (seperti listrik AC

dari dinding) menjadi tegangan DC yang stabil pada 12 volt. Adaptor ini

digunakan untuk memberi daya pada berbagai perangkat elektronik dan

sistem yang memerlukan input tegangan 12V DC.

Karakteristik Adaptor 12 Volt:

1. Input dan Output Tegangan:

1. Input Tegangan: Biasanya menerima tegangan AC dari sumber

listrik rumah, seperti 110V atau 220V tergantung pada standar

lokal.

2. Output Tegangan: Menghasilkan tegangan DC stabil sebesar 12V.

2. Jenis:

1. Adaptor AC-DC: Mengubah tegangan AC dari dinding menjadi

tegangan DC yang diperlukan oleh perangkat.

2. Adaptor DC-DC: Mengubah tegangan DC dari sumber lain

(misalnya baterai) menjadi 12V DC.

3. Kapasitas Arus: Adaptor 12V tersedia dalam berbagai kapasitas arus

(misalnya 1A, 2A, 5A) untuk memenuhi kebutuhan daya perangkat yang

berbeda.

4. Stabilitas Tegangan: Adaptor yang baik akan menyediakan tegangan 12V

yang stabil, meskipun terjadi fluktuasi dalam input atau perubahan beban.



Gambar 2. 10Adaptor 12
Volt

2.15 Stepdown LM2596
( Menurut Texas Instruments 2020 ) LM2596 adalah sebuah jenis

regulator tegangan step-down (juga dikenal sebagai buck converter) yang

dirancang untuk mengubah tegangan DC yang lebih tinggi menjadi tegangan DC

yang lebih rendah dengan efisiensi tinggi. Regulator ini dibuat oleh Texas

Instruments dan merupakan salah satu komponen yang sering digunakan dalam

berbagai aplikasi untuk menyediakan catu daya yang stabil.

Karakteristik LM2596:

1. Fungsi Step-Down: LM2596 dirancang untuk mengubah tegangan input

yang lebih tinggi (misalnya 12V, 24V) menjadi tegangan output yang

lebih rendah (misalnya 5V, 3.3V) dengan efisiensi konversi yang tinggi.

2. Rentang Tegangan Input: Biasanya, LM2596 dapat menerima rentang

tegangan input antara 4V hingga 40V.



3. Tegangan Output: Output tegangan dapat diatur menggunakan resistor

eksternal untuk menghasilkan tegangan tetap yang diinginkan, seringkali

dalam rentang 1.23V hingga 37V.

4. Arus Output: Dapat menyediakan arus output yang cukup besar, hingga

3A pada konfigurasi standar.

5. Efisiensi Tinggi: Memiliki efisiensi konversi yang tinggi, biasanya

mencapai sekitar 75% hingga 80%, tergantung pada aplikasi dan beban.

6. Proteksi: Dilengkapi dengan fitur perlindungan seperti proteksi terhadap

arus lebih (overcurrent) dan perlindungan termal (thermal shutdown).

Gambar 2. 11 Stepdown LM2596

2.16 ESP32-CAM

ESP32-CAM adalah modul kamera berbasis mikrokontroler yang

menggunakan chip ESP32 dari Espressif Systems. Modul ini menggabungkan

kemampuan pemrosesan dan konektivitas nirkabel dari ESP32 dengan kamera

kecil (biasanya OV2640) untuk menghasilkan gambar dan video. ESP32-CAM



sering digunakan dalam aplikasi IoT (Internet of Things), pengawasan,

pengenalan wajah, dan proyek DIY (Do-It-Yourself) lainnya karena ukurannya

yang kecil, biaya rendah, dan fungsionalitas yang kuat.

Fitur Utama ESP32-CAM:

1. Mikrokontroler ESP32: Dilengkapi dengan chip ESP32 yang

mendukung Wi-Fi dan Bluetooth, memberikan konektivitas yang

diperlukan untuk aplikasi jarak jauh atau nirkabel.

2. Kamera OV2640: Kamera CMOS kecil dengan resolusi hingga 2MP

(megapiksel) yang dapat menangkap gambar dan video.

3. Antena Wi-Fi: Dapat menggunakan antena PCB bawaan atau antena

eksternal untuk meningkatkan jangkauan Wi-Fi.

4. GPIO (General-Purpose Input/Output): Terdapat beberapa pin GPIO

yang dapat digunakan untuk menghubungkan sensor, aktuator, atau

perangkat lain.

5. Dukungan MicroSD: Slot untuk kartu MicroSD memungkinkan

penyimpanan lokal untuk gambar, video, atau data lainnya.

6. Pemrograman yang Fleksibel: Dapat diprogram menggunakan Arduino

IDE atau platform lainnya, menjadikannya pilihan yang fleksibel untuk

pengembang.

Aplikasi ESP32-CAM:

 Pengawasan dan Keamanan: Digunakan dalam sistem CCTV DIY untuk

pengawasan rumah atau kantor.

 Pengenalan Wajah: Proyek dengan pengenalan wajah untuk akses

kontrol atau aplikasi terkait AI.

 Proyek IoT: Menyediakan gambar dan data video untuk aplikasi IoT

seperti monitoring lingkungan atau proyek rumah pintar.



Gambar 2.12 ESP32 Cam

2.17 Arduino IDE

( Menurut Banzi, Massimo, and Michael Shiloh 2014 ) Arduino IDE

(Integrated Development Environment) adalah perangkat lunak yang digunakan

untuk menulis, mengedit, dan mengunggah kode program (sketch) ke papan

mikrokontroler Arduino. IDE ini dirancang untuk memudahkan pengguna dalam

mengembangkan proyek berbasis Arduino dengan menyediakan antarmuka yang

sederhana dan intuitif.

Karakteristik Arduino IDE:

1. Antarmuka Pengguna yang Sederhana: Arduino IDE memiliki antarmuka

yang mudah digunakan, dengan editor teks untuk menulis kode, dan

berbagai alat untuk mengelola proyek.

2. Pustaka dan Contoh Kode: Menyediakan pustaka dan contoh kode (sketch)

yang membantu pengguna memahami cara menggunakan berbagai fungsi

dan perangkat keras Arduino.

3. Compiler dan Upload: Mencakup compiler untuk mengonversi kode

sumber menjadi file yang dapat dijalankan oleh mikrokontroler Arduino,



serta alat untuk mengunggah kode ke papan mikrokontroler melalui

koneksi USB.

4. Dukungan Multiplatform: Arduino IDE tersedia untuk berbagai sistem

operasi, termasuk Windows, macOS, dan Linux.

5. Pustaka dan Ekstensi: Mendukung berbagai pustaka dan ekstensi untuk

menambahkan fungsi tambahan dan mendukung berbagai modul dan

sensor.

Gambar 2.13 arduino ide

2.18 blynk

( Menurut Finkelstein, J. & Anderson, T 2017 ) Blynk adalah sebuah

platform IoT (Internet of Things) yang dirancang untuk memudahkan pembuatan

aplikasi untuk mengendalikan perangkat elektronik secara jarak jauh melalui

smartphone. Blynk menyediakan antarmuka pengguna yang intuitif dan alat yang

memungkinkan pengembangan aplikasi IoT tanpa perlu menulis banyak kode.

Blynk tersedia secara open souce (gratis) atau subscription

(berbayar). Platform ini tersedia pada website serta smartphone Android dan IOS.



Langkah - langkah untuk membuat akun blynk ialah sebagai berikut :

1. Silahkan dibuka browser di laptop / komputer masing-masing dan

lakukan searching untuk mencari website Blynk IoT atau langsung menuju URL

https://blynk.io/.

2. Setelah terbuka website-nya, silahkan klik “Log In“, maka kita akan masuk ke

akun Blynk (jika sudah punya akun).

3. Jika belum punya silahkan daftar lebih dulu dengan klik “Create a New

Account” setelah klik “Log In” tadi.

4. Kemudian kita akan membuat template untuk program kita. Silahkan klik

“Create a new template“.

5. Lalu isikan Nama, Hardware, Tipe Koneksi dan Deskripsinya. Kemudian

setelah selesai klik “Done“.

Kita bisa mengatur template mulai dari Info, Metadata, Datastreams, Event,

Automations, Web Dashboard, dan Mobile Dashboard.

2.19 Flowchart

( Menurut Sharma, Ramesh 2018 ) Flowchart adalah diagram yang

digunakan untuk menggambarkan alur proses, sistem, atau algoritma dengan

menggunakan simbol-simbol grafis. Flowchart membantu dalam merancang,

menganalisis, dan memvisualisasikan langkah-langkah dalam suatu proses atau

sistem, serta memudahkan pemahaman dan komunikasi mengenai alur kerja atau

logika.

Karakteristik Flowchart:

1. Simbol-Simbol Grafis: Flowchart menggunakan berbagai simbol untuk

mewakili elemen proses, seperti:

1. Oval: Menunjukkan awal atau akhir dari suatu proses.

2. Persegi Panjang: Mewakili langkah-langkah atau proses dalam alur.

https://blynk.io/.


3. Belah Ketupat: Digunakan untuk keputusan atau kondisi yang

memerlukan cabang alur.

4. Paralelogram: Digunakan untuk input atau output data.

5. Panah: Menghubungkan simbol-simbol dan menunjukkan arah alur

proses.

2. Alur Proses: Menunjukkan urutan langkah-langkah yang harus diikuti

dalam suatu proses atau algoritma, dengan jelas menunjukkan hubungan

antara langkah-langkah tersebut.

3. Keterbacaan: Flowchart dirancang untuk memudahkan pemahaman alur

proses atau algoritma dengan visualisasi yang jelas dan mudah dibaca.



Gambar 2.14 fungsi flowchart
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